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RNA 9000 Purity & Integrity Kit

The RNA 9000 Purity & Integrity kit contains reagents and supplies for sample preparation and
methods to resolve RNA fragments by size and to quantify heterogeneity and impurities that
might exist in an RNA preparation.

This document gives instructions for sample preparation with the RNA 9000 Purity & Integrity kit.
It also gives instructions for data acquisition and data analysis with the PA 800 Plus software.

Use the information in this application guide as a place to start. If required, change the injection
time, voltage, injection type, or other parameters to find the best conditions for the requirements.

Note: For instructions about how to use the system safely, refer to the document: Overview
Guide.

Safety
Refer to the safety data sheets (SDSs), which are available at sciex.com/tech-regulatory,
for information about the correct handling of materials and reagents. Always follow standard
laboratory safety guidelines. For information about hazardous substances, refer to the section:
Hazardous Substance Information.

Intended Use
The RNA 9000 Purity & Integrity kit is for laboratory use only.

Introduction
The RNA 9000 Purity & Integrity kit is designed for biopharmaceutical scientists working on next
generation RNA therapeutics. This kit provides high analytical resolution, helps alleviate method
complexity, and simplifies transferability. The kit has been validated on both the PA 800 Plus and
BioPhase 8800 systems.

The methodology involves heat denaturation of an RNA sample followed by immediate cooling
in an ice water bath. This forces the nucleic acid into the structure that has the most consistent
mobility during the separation.

The RNA sample is separated by size in a bare-fused silica capillary containing a replaceable
polymer gel that provides sieving selectivity while concurrently limiting counter electroosmotic
flow (EOF). The fluorescent labeling dye SYBR™ Green II RNA Gel Stain1 is added to the

1 SYBR™ is a trademark of the Life Technologies Corporation. SYBR™ Green II RNA Gel Stain is not available for
resale.
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polymer gel matrix during reagent preparation. The dye preferentially binds to RNA molecules so
that the RNA can be detected by laser-induced fluorescence (LIF) during the separation.

Two separation methods were developed for this application: one that uses an electrokinetic
injection, and the other that uses a pressure injection. Both methods provide size-based
separation for RNA molecules between 0.05 kb and 9 kb in approximately 40 minutes. For
information about the injection types, refer to the section: Guidance for Selection of the Injection
Type.

Workflow
Table 1 RNA 9000 Purity & Integrity Kit Workflow

Step To Do This Refer To

1 Prepare the RNA sample at a
concentration between 50 ng/mL to
50 μg/mL.

The RNA preparation procedure for the
laboratory.

2 (Optional) Dilute the ssRNA Ladder with
Sample Loading Solution or nuclease-
free water, denature at 70 °C for 5
minutes, and then cool immediately.

Prepare the ssRNA Ladder

3 Dilute each RNA sample with Sample
Loading Solution or nuclease-free water,
denature at 70 °C for 5 minutes, and then
cool immediately.

Prepare the RNA Sample

4 Install the LIF detector. Install the LIF Detector

5 Install the cartridge. Install the Cartridge

6 Load the sample tray. Load the Sample Tray

7 Prepare the gel buffer and load the buffer
trays.

Load the Buffer Trays

8 For PA 800 Plus software users, create
the RNA 9000 instrument and projects.

Create the Example Instrument and
Create the Example Project

9 In the PA 800 Plus software, create
a sequence and then start the run.
Make sure that the sequence ends
with the RNA 9000 Capillary
Shutdown.met method.

Create the Sequence and Start the Run

10 After the run, store the cartridge. Store the Cartridge

11 Analyze the data. Analyze the Data

RNA 9000 Purity & Integrity Kit
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Required Equipment and Materials
Note: For items with a reorder part number, sometimes the reorder quantity is different than the
quantity in the kit.

Note: The RNA 9000 Purity & Integrity kit (PN C48231) is packaged as two parts: Nucleic
Acid Extended Range Purity & Integrity kit (PN 5087900) and ssRNA Ladder (0.05-9 kb) (PN
5088699). Neither part can be ordered separately.

Note: The ssRNA Ladder in the RNA 9000 Purity & Integrity kit (PN C48231) is shipped
separately from the other kit components.

Table 2 RNA 9000 Purity & Integrity Kit (PN C48231)

Component Quantity Reorder Part
Number

Nucleic Acid Extended Range Purity & Integrity Kit (PN 5087900) N/A

Acid wash/regenerating solution (100 mL) 1 5312349

CE Grade water (140 mL) 2 C48034

LIF Performance Test Mix (20 mL) 1 726022

Nucleic Acid Extended Range Gel (140 mL) 2 N/A

SYBR™ Green II RNA Gel Stain2 (500×) (0.11 mL) 7 N/A

ssRNA Ladder (0.05-9 kb) (PN 5088699) N/A

ssRNA Ladder (0.05 kb to 9 kb) (70 μL) (shipped
separately)

2 N/A

Table 3 Other Supplies from SCIEX

Component Quantity Part Number

Capillary, bare fused-silica (50 μm i.d. × 67 cm long) 1 338451

Capillary cartridge, blank 1 144738

Capillary cartridge, pre-assembled 1 A55625

Filter, 520 nm emission filter 1 144940

LIF Cartridge Aperture Plug Assembly 1 721125

2 SYBR™ is a trademark of the Life Technologies Corporation. SYBR™ Green II RNA Gel Stain is not available for
resale.
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Table 3 Other Supplies from SCIEX (continued)

Component Quantity Part Number

LIF Cartridge Probe Guide Assembly 1 721126

PCR microvials (200 µL) 100 144709

Sample Loading Solution 6 mL 608082

Universal vial caps, blue 100 A62250

Universal vials 100 A62251

Table 4 Other Required Reagents or Supplies

Description Vendor Part Number

Acrodisc 32 mm syringe filter with a 0.45 μm pore-size
membrane

Pall 4654

Luer-Lok tip disposable syringe (10 mL) BD 309604

(Optional) Nuclease-free water (10 × 2 mL) Integrated DNA
Technologies

11-04-02-01

(Optional) RNaseZap RNase Decontamination Solution
(250 mL)

Thermo Fisher
Scientific

AM9780

Storage Conditions
• Upon receipt, to reduce photobleaching of the SYBR™ Green II RNA Gel Stain, remove the

SYBR™ Green II RNA Gel Stain3 from the box, immediately wrap it in aluminum foil, and then
keep at –35 °C to –15 °C.

• Upon receipt, keep the following at 2 °C to 8 °C:

• Nucleic Acid Extended Range Gel

• LIF Performance Test Mix

• Upon receipt, keep the ssRNA Ladder at –35 °C to –15 °C.

• Keep the remaining contents of the kit at ambient temperature.

Customer-Supplied Equipment and Supplies
• Powder-free gloves, neoprene or nitrile recommended

3 SYBR™ is a trademark of the Life Technologies Corporation. SYBR™ Green II RNA Gel Stain is not available for
resale.
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• Protective eyewear

• Laboratory coat

• Analytical balance

• Microcentrifuge, or equivalent, and nuclease-free microcentrifuge tubes (USA Scientific PN
1615-5510)

• PCR tubes, 0.2 mL flat-cap nuclease-free (VWR USA PN 20170-012 or VWR EUR PN
732-0548)

• Ice

• Pipettes and applicable nuclease-free tips

• Table-top mini centrifuge

• Vortex mixer

• Water bath or heat block capable of 37 °C to 100 °C

Required Detector
A laser-induced fluorescence (LIF) detector with an excitation wavelength of 488 nm and a
520 nm emission filter is required.

Required Cartridge or Capillary
CAUTION: Potential Wrong Result. If a capillary is used with the RNA 9000 Purity &
Integrity kit, then do not use the same capillary for another application. Mixing different
buffers and sample types can cause sample carryover, nonspecific binding, and poor
separation.

One of the following:

• Pre-assembled cartridge (PN A55625), with a total length of 30.2 cm and 50 μm inner
diameter (i.d.)

• Capillary cartridge (PN 144738) and bare-fused silica capillaries, 50 μm inner diameter (i.d.) ×
67 cm (PN 338451)

Condition the Capillary

CAUTION: Potential Wrong Result. Do not use a basic solution to clean the capillary.
The solution might negatively ionize the capillary wall and result in electro-osmotic
flow detrimental to the separation of nucleic acids. These interactions might cause poor
separation.

• Before a new capillary is used, condition the capillary with the RNA 9000 Capillary
Conditioning.met method.
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Methods and Sequences
Download the methods and sequences from sciex.com/products/methods. The methods and
sequences can also be created manually with the 32 Karat software. Refer to the section:
Methods.

Save the methods to the PA 800 Plus controller: C:\32Karat\projects\RNA
9000\Method.

Save the sequence to: C:\32Karat\projects\RNA 9000\Sequence.

At the time of publication, the following methods and sequence are available on the SCIEX
website:

• Methods:

• RNA 9000 Capillary Conditioning.met: Conditions the capillary.

• Separation methods:

• RNA 9000 Separation Method - Electrokinetic Injection.met:
Separates the sample with an electrokinetic injection of the sample.

• RNA 9000 Separation - Pressure Injection.met: Separates the sample with
a pressure injection of the sample.

• RNA 9000 Capillary Shutdown.met: Cleans the capillary at the end of a sequence
and turns off the light source.

• Capillary Rinse - RNA 9000.met: Rinses the capillary. To save time after the
capillary has been conditioned, replace RNA 9000 Capillary Conditioning.met
with this method in the sequence.

• ANALYSIS - RNA 9000 - ssRNA Ladder.met: Contains the default integration
parameters and named peaks to aid in the analysis of the ssRNA Ladder.

• Sequences:

• RNA 9000 Test Sequence-EKI.seq: A sequence with the separation method that
uses electrokinetic sample injection.

• RNA 9000 Test Sequence-Pressure Injection.seq: A sequence with the
separation method that uses pressure injection.

Prepare the Samples
Best Practices for Working with RNA
Controlling RNase contamination is critical to the successful analysis of RNA. Precautions must
be taken to ensure RNA integrity prior to ssRNA ladder or RNA sample separation. RNases are
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prevalent on human skin, perspiration, and saliva as well as bacteria and fungi spores and are
therefore ubiquitous to the lab environment. Proper laboratory procedures will help control RNA
degradation from RNases.

1. Wear gloves at all times and change gloves often when handling RNA samples.

2. Designate an RNase-free lab area and use RNase decontaminating reagents such as
RNaseZap RNase Decontamination Solution or MP Bio RNase Erase Decontamination
Solution for bench surfaces, lab racks, and micropipettors. Also, use a lab apparatus
capable of UV-light disinfection to help control RNase contamination.

3. Dedicate pipettes for RNA use and use filtered pipette tips that are certified nuclease-free to
decrease cross-contamination.

4. For anything that comes into contact with RNA, use nuclease-free plastic vials and labware.
Before adding any RNA, shield plasticware from environmental contamination by covering
and working in areas that limit airflow.

5. Use reagents such as nuclease-free water during RNA sample preparation. Use of Sample
Loading Solution or deionized formamide during RNA sample preparation promotes an
environment that stabilizes RNA and prevents RNA degradation from RNases.

Note: CE Grade water is not certified as nuclease-free.

Prepare the ssRNA Ladder
Note: Use the ssRNA Ladder as a qualitative reference for estimating the size of an unknown
RNA sample. It is not intended to be a quantitative standard.

1. Prepare the ssRNA Ladder.

a. For the initial run, remove the vial of ssRNA Ladder from the freezer, and then let it
thaw on ice.

b. With a vortex mixer, mix briefly for a few seconds, and then use a centrifuge to spin the
vial for a few seconds to bring the solution to the bottom of the vial.

c. Measure out the solution in 8 μL aliquots into nuclease-free PCR vials.

d. Reserve one aliquot, and then store the remaining aliquots at –35 °C to –15 °C.

2. Use one of the 8 μL aliquots of the ssRNA Ladder. If it is frozen, then thaw it on ice before
use.

3. For every 50 μL of RNA sample, add 2 μL of the ssRNA Ladder to 48 μL of Sample Loading
Solution.

4. Heat the sample at 70 °C for 5 minutes.

5. After 5 minutes, immediately put the mixture in an ice water bath for a minimum
of 2 minutes.
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Note: Rapid cooling forces the RNA into a structure that gives the best separation results.

6. Put a microvial in a universal vial, and then put the universal vial in the sample tray.

7. Add between 50 μL and 200 μL of the cooled RNA solution to the microvial, and then cap
the universal vial with a blue cap.

8. Put the sample tray in the system. Make sure that the sample compartment temperature is
set to 10 °C.

Note: If the LIF laser is not warm, then do not put the sample tray in the system. Instead,
keep the tray between 2 °C and 8 °C while the laser becomes warm, and then put the
sample tray in the system.

Prepare the RNA Sample
1. Thaw the RNA aliquot on ice.

Keep the sample cool to help prevent the RNA from degrading.

2. Prepare the RNA sample in Sample Loading Solution or nuclease-free water between
50 ng/mL to 50 μg/mL.
We recommend an RNA concentration between 1 μg/mL and 5 μg/mL.

Note: To use a higher sample concentration, increase the Dynamic range from 100 to
1,000 in the LIF Detector Initial Conditions tab in the separation method.

3. Heat the sample at 70 °C for 5 minutes.

4. After 5 minutes, immediately put the mixture in an ice water bath for a minimum
of 2 minutes.

Note: Rapid cooling forces the RNA into a structure that gives the best separation results.

5. Put a microvial in a universal vial, and then put the universal vial in the sample tray.

6. Add between 50 μL and 200 μL of the cooled RNA solution to the microvial, and then cap
the universal vial with a blue cap.

7. Put the sample tray in the system. Make sure that the sample compartment temperature is
set to 10 °C.

Note: If the LIF laser is not warm, then do not put the sample tray in the system. Instead,
keep the tray between 2 °C and 8 °C while the laser becomes warm, and then put the
sample tray in the system.

Prepare the PA 800 Plus System
Use the procedures in this section to prepare the PA 800 Plus system to acquire data.
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Tip! To save time, turn on the light source 30 minutes before the start of the run to let it become
warm.

Install the LIF Detector
1. Turn off the PA 800 Plus system.

2. Install the LIF detector. For detailed instructions, refer to the document: Maintenance Guide.

3. Turn on the system.

4. Turn on the laser, and then let it become warm for at least 30 minutes.

Clean the Electrodes, Insertion Levers, and Interface Block
CAUTION: Potential System Damage. Do not let the gel collect on the electrodes,
opening levers, capillary tips, and interface block. Gel accumulation might cause broken
capillaries, bent electrodes, jammed vials, or missed injections.

Clean the electrodes, opening levers, capillary tips, and interface block after every use or when
chemistries are changed. For detailed instructions, refer to the section: "Clean the Electrodes,
Insertion Levers, and Interface Block" in the document: Maintenance Guide.

The gel buffer is very viscous. To make sure that gel buffer does not collect in the system, do
regular and thorough cleaning.

Install the Capillary
CAUTION: Potential System Damage. Do not cut the capillary to its final length before it is
installed in the cartridge.

• Install the capillary into a capillary cartridge. Refer to the document: Capillary Cartridge
Rebuild Instructions.

The recommended capillary length is 20 cm to the window and 30.2 cm total length.
Use the LIF aperture and probe guide.

Install the Cartridge
1. Remove the cartridge from the box.

2. For a pre-assembled cartridge, remove the aperture from the cartridge, and then install the
LIF aperture and probe guide. For detailed instructions, refer to the document: Maintenance
Guide.

3. Install the cartridge in the PA 800 Plus system. For detailed instructions, refer to the
document: Maintenance Guide.

4. (Optional) Calibrate the LIF detector.
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Use the Calibration wizard, which is available from the Instrument Configuration dialog
in the 32 Karat software. For detailed instructions, refer to the section: Calibrate the LIF
Detector (Optional).

Load the Buffer Trays
Note: The gel buffer and dye mixture is referred to as gel buffer in this document.

CAUTION: Potential Wrong Result. Do not prepare the gel buffer before it is required.
Degradation of the SYBR™ Green II RNA Gel Stain in the gel buffer might occur during
storage and cause peaks with decreased intensity.

CAUTION: Potential System Damage. Do not fill any vial with more than 1.5 mL of liquid.
Fill waste vials with 1.0 mL of liquid. Do not let more than 1.5 mL of liquid collect in waste
vials. If a vial is filled with more than 1.5 mL of liquid, then the pressure system can be
damaged.

Note: To prevent air bubbles, do not shake or vigorously mix the gel buffer. Air bubbles might
cause issues with the separation.

Note: Do not reuse the vials or caps, because they might be contaminated with dried gel and
other chemicals.

1. Add the following reagents to a conical tube, and then gently invert the tube a minimum of
20 times.
While inverting the tube, make sure that no bubbles are formed.

Table 5 Gel Buffer (Nucleic Acid Extended Range Gel with SYBR™ Green II RNA Gel
Stain)

Reagent For 1 to 8
Samples

For 9 to 16
Samples

For 41 to 48
Samples

Nucleic Acid Extended Range Gel 5 mL 10 mL 30 mL

SYBR™ Green II RNA Gel Stain4 10 μL 20 μL 60 μL

Tip! Wrap the tube that contains the prepared gel buffer in aluminum foil to decrease
photobleaching of the SYBR™ Green II RNA Gel Stain.

2. With a 0.45 μm Acrodisc syringe filter and a Luer-Lok syringe, filter the gel buffer.

4 SYBR™ is a trademark of the Life Technologies Corporation. SYBR™ Green II RNA Gel Stain is not available for
resale.
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3. Use the layout in the following figure to put the vials in the buffer trays. Each row is sufficient
for at least eight runs. The following figure shows the layout for at least 16 runs.

Note: The separation methods are programmed to increment after eight runs.

Figure 1 Buffer Tray Layout

Note: For fewer than 8 samples, fill only row 1.

4. Fill the vials as shown in the following table, and then attach the cap. Refer to the following
figure.

Table 6 Vials to Prepare

Label No. of Vials Vol./Vial (mL) Reagent

Water 10 1.5 CE Grade water

Gel 6 1.5 Gel buffer with SYBR™ Green II RNA Gel
Stain

HCl 2 1.5 Acid wash/regenerating solution

Waste 6 1.0 CE Grade water
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Figure 2 Universal Vial and Cap Setup

Item Description

1 Universal vial cap

2 Maximum fill line

3 Universal vial

Load the Sample Tray
Note: Do not reuse the vials or caps, because they might be contaminated with dried gel and
other chemicals.

Note: For workflows that have small sample volumes, SCIEX sells vials that are specially made
for small volumes. For volumes between 5 μL and 50 μL, with a standard volume of 25 μL,
use nanoVials. For volumes between 20 μL and 200 μL, with a standard volume of 100 μL, use
microvials.

1. Add the samples to the microvials. For each sample:

a. Transfer between 50 µL to 200 μL of the sample to a microvial.

b. Put a blue cap on the universal vial. Refer to the figure: Figure 3.
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Figure 3 Microvial in a Universal Vial

Item Description

1 Universal vial cap

2 Microvial

3 Universal vial

4 Microvial inside a universal vial

2. Put each universal vial in the sample tray. Refer to the figure: Figure 4.
Position A1 is for the ssRNA Ladder. Use the other positions for the other samples.
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Figure 4 Sample Tray Layout

Run the Samples
Tips for Best Results
SCIEX tested the separation performance of the ssRNA Ladder and other characteristics over a
range of temperatures. 30 °C is used in the separation methods because it gave the best overall
results.

If a specific characteristic is to be maximized, other temperatures can be used. Refer to the
table: Table 7.
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Table 7 Guidance for Setting the Capillary Temperature

Capillary
Temperature (°C)

Capillary Run Life 9 kb Peak
Migration Time

(minutes)

Optimal Resolution by RNA
Length

3 kb to 5 kb ≥ 5 kb

25 Highest ~21

30 Higher ~20

35 Medium ~19

40 Lower ~17

Note: The capillary run life (the number of injections that can be done) depends on the sample
and the separation method. The preceding table shows how performance changes based on the
capillary temperature. In general, a lower temperature increases the capillary run life.

Use the Rinse Method
A rinse method is supplied with the other methods for the kit.

To save time after the capillary has been conditioned, in the sequence, use the Capillary
Rinse - RNA 9000.met method as an alternative to the RNA 9000 Capillary
Conditioning.met method. The rinse method is approximately 30 minutes shorter than the
conditioning method.

Guidance for Selection of the Injection Type
Two separation methods are supplied with the kit, one with an electrokinetic injection and one
with a pressure injection. This section gives an explanation of the differences between the
two types of injection. Select the separation method that is compatible with the goal of the
experiment.

• Electrokinetic injection (EKI) uses an electric field to introduce the negatively charged RNA
into the capillary.

• Advantages: Assay sensitivity throughout the full separation range can be increased with a
larger injection volume or more concentrated samples.

• Disadvantages: Samples with higher ionic strength will have a lower signal intensity as a
result of injection competition between nucleic acids and anions in solution. ssRNA ladder
and sample peaks shorter than 300 bases might be more difficult to interpret and integrate
as a result of decreased peak selectivity during electrokinetic sample introduction.

• Hydrodynamic (pressure) injection uses pressure-over-liquid to introduce the sample to the
capillary.
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• Advantages: Peak height is more consistent because the ionic strength in the sample does
not change from injection to injection. Peaks below 300 bases keep peak selectivity which
simplifies integration and analysis.

• Disadvantages: Assay sensitivity is decreased compared to electrokinetic injection.

The following figures show electropherograms of the separation of the ssRNA Ladder with the
different sample injection methods. (Only the peaks from 50 bases to 300 bases are shown.)
With electrokinetic injection the peak labeled 50 is much broader and thus has lower theoretical
plates as compared to the same peak from a pressure injection. Refer to the figures: Figure 5
and Figure 6.

Figure 5 ssRNA Ladder Sample with Electrokinetic Injection, Annotated with Length and
Theoretical Plates
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Figure 6 ssRNA Ladder Sample with Pressure Injection, Annotated with Length and
Theoretical Plates

Create the Example Instrument
Note: The following procedure is required if the PA 800 Plus software will be used for data
acquisition and analysis. If the 32 Karat software will be used instead, then this procedure is not
required.

This procedure requires the user name and password for a user with administrative privileges for
the 32 Karat software.

For detailed instructions, refer to the documents: 32 Karat Software Help or Methods
Development Guide.

1. Double-click the 32 Karat icon on the desktop.

2. Click Tools > Enterprise Login, type the user name and password, and then click Login.

3. Click Tools > System Administration Wizard.
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Figure 7 Select Administration Wizard Window

4. Click Instrument, and then click Next.

5. Follow the instructions in the wizard to create the instrument. When prompted for the
instrument name, type RNA 9000.
The PA 800 plus System Configuration dialog opens.

6. Click LIF Detector, , and then click OK.

7. Do one of the following:

• If the system is connected to the controller and it is turned on, then click Auto
Configuration.

• If the system is not connected to the controller or it is turned off, then in the Configured
modules list, right-click LIF Detector and select Open. Make sure that the trays are
configured correctly, and then click OK.

8. Click OK.
The PA 800 plus System Configuration dialog closes.
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Create the Example Project
Note: The following procedure is required if the PA 800 Plus software will be used for data
acquisition and analysis. If the 32 Karat software will be used instead, then this procedure is not
required.

This procedure requires the user name and password for a user with administrative privileges for
the 32 Karat software.

1. Double-click the 32 Karat software icon on the desktop.
If the 32 Karat software is already open, close any instrument windows that are open.

2. Click Tools > Enterprise Login, type the user name and password, and then click Login.

3. Click Tools > System Administration Wizard.

Figure 8 Select Administration Wizard Window

4. Click Project and then click Next.

5. Follow the instructions in the wizard to create the project. When prompted for the project
name, type RNA 9000.
Make sure to assign users to the project.

For detailed instructions, refer to the documents: 32 Karat Software Help or System
Administration Guide.
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6. If required, then download the method and sequence files from the SCIEX website. Refer to
the section: Methods and Sequences.

7. Copy the methods to the methods folder for the project. By default, this is C:
\32Karat\projects\RNA 9000\Method.

8. Copy the sequence to the sequence folder for the project. By default, this is C:
\32Karat\projects\RNA 9000\Sequence.

Create the Sequence and Start the Run
1. Double-click the PA 800 Plus software icon on the desktop.

The PA 800 plus window opens

2. In the upper right corner of the PA 800 plus window, click  (Run).
The Instrument Status and Direct Control page opens.

Figure 9 Instrument Status and Direct Control Window

3. Click  (Describe).

4. In the Application list, click RNA 9000.

5. In the Sequence list, click Browse, and then browse to the sequence. Choose either of the
following:
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• RNA 9000 Test Sequence-EKI.seq
• RNA 9000 Test Sequence-Pressure Injection.seq
For information about the injection types, refer to the section: Guidance for Selection of the
Injection Type.

6. If a prompt is shown, then type a user name and password.
The page changes to show the selected sequence, and all of the rows in the sequence are
designated as samples.

7. Click the first row to select it, and then click  (Control) in the Rows area.
The first row contains the ssRNA Ladder.
The icon in the Type column in the first row in the sequence changes to a square.

8. Click the last row (with the RNA 9000 Capillary Shutdown.met method), and then

click  (Always) in the Rows area.
The icon in the Type column in the sequence changes to a triangle.

Note: If the RNA 9000 Test Sequence-Pressure Injection.seq sequence was
selected in step 5, then the information in the Method column is different in the following
figure.
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Figure 10 Describe sequence rows and columns Window

9. In the lower right corner of the window, click  (Save), and then click 
(Finish).

10. To set the number of samples, in the Number of samples field, click the arrow buttons.

Figure 11 Set the Number of Samples

As the number of samples changes, the images of the buffer and sample trays on the right
change to show the correct number of vials and their locations for the run. For example,
in Figure 1, one row of reagents is required for eight samples. Two rows of reagents are
required for 16 samples.
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Figure 12 Tray Map

11. If the buffer and sample trays have not been loaded, then click  (Load), load the
buffer and sample trays in the PA 800 Plus system, and then close the door.

12. Click  (Next), and then click Yes - run now.

Figure 13 Samples Loaded Prompt
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Figure 14 PA 800 Software During Data Acquisition

Waste Disposal
WARNING! Biohazard or Toxic Chemical Hazard. Obey local directives to
discard chemicals, cartridges, buffer trays, sample trays, vials and caps,
and the remains of the prepared samples. They might contain regulated
compounds and biohazardous agents.

Store the Cartridge
Store the Cartridge Less Than 24 Hours
1. Use the shutdown method to clean the capillary.

The shutdown method fills the capillary with CE Grade water and decreases the cartridge
temperature to 15 °C.

2. Keep the cartridge up to 24 hours in the system, with the capillary tips immersed in vials of
CE Grade water.

Store the Cartridge More Than 24 Hours
1. Use the shutdown method to clean the capillary.
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The shutdown method fills the capillary with CE Grade water and decreases the cartridge
temperature to 15 °C.

2. Remove the cartridge from the system.

3. Put the cartridge in the cartridge storage box with the capillary tips immersed in vials of CE
Grade water.

4. Keep the cartridge storage box upright in the refrigerator between 2 °C and 8 °C.

Prepare the Cartridge After Storage
• If the cartridge has not been used for more than a day, then use the Capillary Rinse -

RNA 9000.met method to rinse the capillary.

Analyze the Data
Analyze the Data for the ssRNA Ladder
1. In the 32 Karat software, open the sequence from the run.

2. Open the data file for the first run.

3. Click File > Open > Method, select ANALYSIS - RNA 9000 - ssRNA Ladder.met,
and then click OK.
For reference, the integration parameters and named peaks table are shown in the following
figures.

Figure 15 Integration Parameters

Note: The peak names correspond to the length of the RNA in the ssRNA Ladder.
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Figure 16 Named Peaks Table

4. Adjust the integration events until all of the peaks in the test sample are integrated correctly.
Refer to the chapter: "Integration" in the document: Methods Development Guide.

5. Click File > Save, to save the method and then apply it to the rows in the sequence that
contain the ssRNA Ladder samples.
The electropherogram is labeled with the peak names for the components of the ssRNA
Ladder.

Figure 17 ssRNA Ladder: Data Collected with Electrokinetic Injection
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Figure 18 ssRNA Ladder: Data Collected with Pressure Injection

Guidance for Acceptance Criteria
To create acceptance criteria for use with this kit for SOPs or other purposes, use parameters
that are inherent to the quality of the separation and attributes that show critical sample qualities.
Differences between gel and capillary lots and different systems might cause variations in
absolute migration times.

For the ssRNA ladder, the ratio between the migration time of the 9 kb and 0.5 kb peaks more
accurately reflects the apparent size of the nucleic acids in the gel and can be used to identify
the resolving power of the separation gel and consistency of the separation. SCIEX strongly
discourages the use of absolute migration time as an acceptance criterion.

Troubleshooting
Note: SYBR™ is a trademark of the Life Technologies Corporation. SYBR™ Green II RNA Gel
Stain is not available for resale.
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Symptom Possible Cause Corrective Action

Broad peaks, poor
resolution

1. The capillary tip is damaged.

2. The sample concentration is
too high.

3. The capillary is blocked.

4. The internal surface of the
capillary is contaminated.

5. The lifetime of the capillary
has been exceeded.

6. The SYBR™ Green II RNA Gel
Stain concentration in the gel
buffer is too high.

1. Inspect the capillary tips under
magnification. If a cut is jagged,
then cut the tip again or replace
the capillary.

2. Do one or all of the following:

• Dilute the sample again with
the sample diluent.

• Decrease the Duration in
the Inject event in the
separation method to inject
less sample. If the results
are not satisfactory, then
decrease the Pressure or
Voltage.

3. Replace the capillary or capillary
cartridge.

4. Replace the capillary or capillary
cartridge.

5. Perform a test separation of
the ssRNA Ladder. If the
peak widths are consistently
wider than previous runs then
replace the capillary or capillary
cartridge.

6. Make sure that the SYBR™

Green II RNA Gel Stain is
diluted between 100× and
1000× in the gel buffer. Refer
to the section: Load the Buffer
Trays.
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Symptom Possible Cause Corrective Action

Broad peaks,
poor resolution
(continued)

1. The Nucleic Acid Extended
Range Gel was left at room
temperature too long.

2. The capillary cartridge was
left at room temperature for
more than a week.

1. Prepare new Nucleic Acid
Extended Range Gel. Make
sure to keep it between 2 °C
and 8 °C. Minimize the time
that the gel is at ambient
temperature.

2. Replace the capillary or capillary
cartridge. For the new capillary,
make sure to run the shutdown
method at the end of the day.

Carryover 1. The sample concentration is
too high.

2. The vials or caps are
contaminated.

1. Do one or all of the following:

• Decrease the Duration in
the Inject event in the
separation method to inject
less sample. If the results
are not satisfactory, then
decrease the Pressure or
Voltage.

• Dilute the sample again with
the sample diluent.

2. Replace the vials and caps, or
change the method:

• Fill clean vials with newly
prepared reagents, cover the
vials with clean caps, and
then replace the vials in the
tray. Do not use vials or caps
more than once.

• Make sure that the waste
vials contain 1.0 mL of water
and have been put in the
outlet buffer tray.

• In the separation method,
add one or more water dip
steps after sample injection.
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Symptom Possible Cause Corrective Action

Extra peaks 1. Non-nucleic acid components
of the sample interacted with
the SYBR™ Green II RNA Gel
Stain.

2. The plasticware used
during sample preparation
or the sample vials are
contaminated with materials
that interact with SYBR™

Green II RNA Gel Stain.

3. Light scattering due to
particulates larger than 1 μm
in the gel buffer.

1. Prepare the sample again.
Make sure it is pure.

2. Prepare the sample again, with
clean plasticware and clean
sample vials. Do not use vials or
caps more than once.

3. Filter the gel buffer with a
syringe filter before adding it to
the buffer trays.

High current 1. The gel buffer is
contaminated.

2. The buffer trays are not set up
correctly.

3. The Nucleic Acid Extended
Range Gel was left at room
temperature too long.

1. Replace the vials and caps with
clean ones. Do not use vials or
caps more than once.

2. Make sure that the vials in the
buffer tray contain the correct
reagents and are in the correct
location. Refer to the section:
Load the Buffer Trays.

3. Prepare new Nucleic Acid
Extended Range Gel. Make
sure to keep it between 2 °C
and 8 °C. Minimize the time
that the gel is at ambient
temperature.
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Symptom Possible Cause Corrective Action

Low signal 1. The capillary tip is dirty or
plugged.

2. The sample concentration is
too low.

3. The salt concentration in the
sample is too high.

4. The initial nucleic acid
concentration is too low.

1. Replace the capillary or capillary
cartridge.

2. Do one or all of the following:

• Increase the Duration up
to 15 seconds in the Inject
event in the separation
method to inject more
sample. If the results are not
satisfactory, then increase
the Pressure or Voltage.

• Prepare the sample again,
with the recommended
concentration. The
recommended concentration
is 50 ng/mL to 50 μg/mL.

3. Do one or all of the following:

• If the separation method
uses an electrokinetic
injection, then use a pressure
injection.

• Prepare the sample at a
lower ionic strength.

4. Do one or all of the following:

• Increase the Duration up
to 15 seconds in the Inject
event in the separation
method to inject more
sample. If the results are not
satisfactory, then increase
the Pressure or Voltage.

• Prepare the sample again,
with the recommended
concentration. The
recommended concentration
is 50 ng/mL to 50 μg/mL.
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Symptom Possible Cause Corrective Action

Low signal
(continued)

1. The nucleic acids in the
sample have degraded due
to the presence of RNAse or
other nucleases.

1. Prepare the sample again.
Make sure to limit exposure to
RNase. Refer to the section:
Best Practices for Working with
RNA.

Low current 1. The capillary tip is dirty or
plugged.

2. The capillary window or tip is
broken.

3. There are dried reagents
on the electrodes, insertion
levers, capillary tips, or
interface block.

4. The buffer trays are not set up
correctly.

1. Replace the capillary or capillary
cartridge.

2. Inspect the capillary window
and tip. If either is broken,
then replace the capillary or the
capillary cartridge.

3. Clean the interface block daily
or as needed. Refer to the
section: Clean the Electrodes,
Insertion Levers, and Interface
Block.

4. Make sure that the vials in the
buffer tray contain the correct
reagents and are in the correct
locations. Refer to the section:
Load the Buffer Trays.

Low or unsteady
current

1. The capillary tip is dirty or
plugged.

2. The gel buffer has air
bubbles.

1. Replace the capillary or capillary
cartridge.

2. Sonicate the buffer from
10 seconds to 20 seconds to
remove air bubbles.
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Symptom Possible Cause Corrective Action

No electrical current
during separation

1. The capillary is damaged.

2. An electrode is broken or
bent.

3. The capillary tip is dirty or
blocked.

4. The buffer trays are not set up
correctly.

5. The capillary is filled with air
bubbles.

6. There are dried reagents
on the electrodes, insertion
levers, capillary tips, or
interface block.

1. Replace the capillary or capillary
cartridge.

2. Replace the electrode.

3. Replace the capillary or capillary
cartridge.

4. Make sure that the vials in the
buffer tray contain the correct
reagents and are in the correct
locations. Refer to the section:
Load the Buffer Trays.

5. Do one or all of the following:

• Make sure that there is
100 µL of sample in the
microvial.

• Make sure that the vials in
the buffer and sample trays
are in the correct locations.
Refer to the sections: Load
the Buffer Trays and Load
the Sample Tray.

• Sonicate the buffer from
10 seconds to 20 seconds to
remove air bubbles.

6. Clean the interface block daily
or as needed. Refer to the
section: Clean the Electrodes,
Insertion Levers, and Interface
Block.
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Symptom Possible Cause Corrective Action

No peaks 1. The lifetime of the LIF
detector laser has been
exceeded.

2. The method parameters are
incorrect.

3. There is an air bubble at the
bottom of the sample vial.

4. The capillary window or tip is
broken.

5. The sample volume is too low.

6. The sample is missing or not
in the correct position in the
sample tray.

7. The capillary was cleaned
with a basic solution such as
0.1 N NaOH.

8. The tip of the capillary
extends beyond the electrode.

1. Contact SCIEX Technical
Support at sciex.com/request-
support.

2. Do the following:

a. Open the separation
method in the software, and
then make sure that the
method is correct. Refer
to the section: Separation
Methods.

b. Make sure that the
positions of the samples
and reagents in the trays
agree with the tray layouts.

3. Use a centrifuge to spin the
sample tube to make sure that
there are no bubbles at the
bottom.

4. Inspect the capillary window
and tip. If either is broken,
then replace the capillary or the
capillary cartridge.

5. Make sure that there is 100 µL
of sample in the microvial.

6. Make sure that the samples
are in the correct locations in
the sample tray. Refer to the
section: Load the Sample Tray.

7. Replace the capillary or capillary
cartridge.

8. Inspect the capillary tips under
magnification. If a tip extends
beyond the electrode, then cut
the tip again or replace the
capillary.
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Symptom Possible Cause Corrective Action

No peaks
(continued)

1. A pipetting error occurred
during preparation of the
sample.

2. The salt concentration in the
sample is too high.

1. Do one or all of the following:

• If the separation method
uses an electrokinetic
injection, then use a pressure
injection.

• Prepare the sample at a
lower ionic strength.

2. Prepare a new sample.

Slower migration
time with or without
concurrent low
current

1. The capillary tip is dirty or
plugged.

1. Replace the capillary or capillary
cartridge.

Dramatic shift in
migration time
between runs on the
same day

1. The capillary has not been
conditioned sufficiently.

2. The gel buffer has
evaporated.

1. Condition the capillary. Refer
to the section: Condition the
Capillary. Do a blank separation
run to equilibrate the capillary
surface.

2. Fill clean vials with newly
prepared reagents, cover the
vials with clean caps, and then
replace the vials in the tray. Do
not use vials or caps more than
once.

Spikes in
electropherogram

1. The gel buffer has air
bubbles.

1. Sonicate the buffer from
10 seconds to 20 seconds
to remove air bubbles. If air
bubbles are still present, then
prepare new gel buffer. Do not
mix the buffer with a vortex
mixer. Carefully invert the tube
a minimum of 20 times.
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Symptom Possible Cause Corrective Action

Broad or split peaks 1. After the denaturation step,
the nucleic acid sample still
has secondary structure.

2. The cooling step after
denaturation was too slow.

3. The SYBR™ Green II RNA Gel
Stain concentration in the gel
buffer is too high.

4. The lifetime of the capillary
has been exceeded.

1. Dilute the samples with Sample
Loading Solution in place of
nuclease-free water.

2. Cool the samples immediately
to prevent the formation of
secondary structure.

3. Make sure that the SYBR™

Green II RNA Gel Stain is
diluted between 100× and
1000× in the gel buffer. Refer
to the section: Load the Buffer
Trays.

4. Do a test separation of
the ssRNA Ladder. If the
peak widths are consistently
wider than previous runs, then
replace the capillary or capillary
cartridge.

Saturated peaks 1. In the LIF Detector Initial
Conditions for the separation
method, the Dynamic range
is too small.

2. The sample concentration is
too high.

1. Increase the value for the
Dynamic range.

2. Do one or all of the following:

a. Dilute the sample again
with the sample diluent.

b. Decrease the Duration in
the Inject event in the
separation method to inject
less sample. If the results
are not satisfactory, then
decrease the Pressure or
Voltage.

Unstable baseline 1. The concentration of dye in
the inlet buffer tray is not the
same as the concentration in
the outlet buffer tray.

1. Make enough gel buffer for both
the inlet and outlet buffer trays.
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Hazardous Substance Information A
The following information must be noted and the relevant safety measures must be obeyed. For
more information, refer to the respective safety data sheets. The safety data sheets are available
on request or can be downloaded from our website, at sciex.com/tech-regulatory.

Hazard classification according to HCS 2012.

Acid wash/regenerating solution

DANGER! Causes severe skin burns and eye damage.

Nucleic Acid Extended Range Gel

DANGER! May damage fertility or the unborn child.

SYBR™ Green II RNA Gel Stain5

WARNING! Combustible liquid.

Other Reagents

These components are not classified as hazardous:

• CE Grade water

• LIF Performance Test Mix

For reagents from other vendors, read the safety data sheet from the vendor before use.

5 SYBR™ is a trademark of the Life Technologies Corporation. SYBR™ Green II RNA Gel Stain is not available for
resale.

Hazardous Substance Information

Application Guide
RUO-IDV-05-13437-D

RNA 9000 Purity & Integrity Kit For the PA 800 Plus
Pharmaceutical Analysis System

41/59

https://sciex.com/tech-regulatory


Methods B
Capillary Conditioning Method
Figure B-1 Initial Conditions Tab

Methods
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Figure B-2 LIF Detector Initial Conditions Tab

Figure B-3 Capillary Conditioning Method Time Program Tab
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Separation Methods
Two separation methods are available: one with an electrokinetic injection and one with a
pressure injection. The parameters on the Initial Conditions and LIF Detector Initial Conditions
tabs are the same for both methods. The parameters on the Time Program tab are different.

Figure B-4 Initial Conditions Tab
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Figure B-5 LIF Detector Initial Conditions Tab

Figure B-6 Time Program Tab for Electrokinetic Injection
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Figure B-7 Time Program Tab for Pressure Injection

Shutdown Method
Figure B-8 Initial Conditions Tab

Methods
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Figure B-9 LIF Detector Initial Conditions Tab

Figure B-10 Shutdown Method Time Program Tab
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Capillary Rinse Method
Figure B-11 Initial Conditions Tab
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Figure B-12 LIF Detector Initial Conditions Tab

Figure B-13 Capilllary Rinse Method Time Program Tab
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Calibrate the LIF Detector (Optional) C
This procedure is optional. If there is a requirement for consistency from system to system or
cartridge to cartridge, then do this procedure. For information about the calibration, refer to the
section: "About Automatic Calibration" in the document: Maintenance Guide.

Calibrate the LIF detector after the LIF detector is installed, after a different cartridge is installed,
or after a new capillary is installed in the cartridge.

Note: The following procedure technically does normalization, not calibration. Normalization
uses a measured quality, such as the fluorescence of the LIF Performance Test Mix. Calibration
uses an external standard. Because the software user interface uses the term calibration, that
term is used in this guide.

Required Materials

• LIF Performance Test Mix

• CE Grade water

1. Turn on the PA 800 Plus system.

2. Open the 32 Karat software.
The 32 Karat Software Enterprise window opens.

3. Open the LIF instrument, open the Direct Control window, and then turn on the laser.

4. In the 32 Karat Software Enterprise window, click Tools > Enterprise Login, and then log
on as a user with Administrative privileges.

5. Right-click the RNA 9000 instrument icon, and then click Configure > Instrument.
The Instrument Configuration dialog opens.

6. Click Configure.
The PA 800 plus Configuration dialog opens.

7. In the right pane, click the LIF Detector icon, and then right-click and click Open.

Calibrate the LIF Detector (Optional)
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Figure C-1 PA 800 plus System Instrument Configuration Dialog for LIF Detectors

8. Click LIF Calibration Wizard.

9. Do the calibration:

a. Click Auto, and then click Next.

Calibrate the LIF Detector (Optional)
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Figure C-2 Calibration Wizard - Step 1

b. In the Target RFU field, type 40.

Note: The Target RFU is 40 so that the signal intensity from the PA 800 Plus system
is almost the same as the signal from a BioPhase 8800 system. It is intended for
transferability.

c. Make sure that the values in the Capillary dimensions section are correct, and then click
Next.

Calibrate the LIF Detector (Optional)
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Figure C-3 Calibration Wizard - Step 2

10. Put a universal vial in position A1 in the buffer outlet tray.

11. Put universal vials in positions A1 and B1 in the buffer inlet tray.

Note: To prevent splashing, put the empty vials in the tray, and then add liquid and attach
the caps.

Calibrate the LIF Detector (Optional)
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Figure C-4 Calibration Wizard - Step 3

12. Fill the vials, and then put caps on the vials:

• Inlet buffer tray position A1 (labeled Buffer): 1.5 mL of CE Grade water

• Inlet buffer tray position B1 (labeled Calibration mix): 1.5 mL of LIF Performance
Test Mix

• Outlet buffer tray position A1 (labeled Waste): 1.0 mL of CE Grade water

13. Click Next.
The 32 Karat software does the calibration. When the calibration is complete, the Calibration
Wizard - Step 4 window opens.

If the message No step change detected is shown, then the detector cannot detect the
solution. For troubleshooting procedures, refer to the section: No Step Change Detected.

14. Examine the value in the Calibration Correction Factor field:

• If the CCF value is less than 0.1, then click Cancel. Refer to the section: CCF Values for
LIF Detector Calibration.

• If the CCF value is between 0.1 and 10, then the calibration was successful. Click
Accept to save the results.

• If the CCF value is more than 10, then click Cancel. Refer to the section: CCF Values for
LIF Detector Calibration.

Calibrate the LIF Detector (Optional)
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Figure C-5 Calibration Wizard - Step 4

15. In the Direct Control window, set the sample storage temperature to 10 °C.

16. Close all of the dialogs and windows.

Troubleshoot the LIF Detector Calibration
CCF Values for LIF Detector Calibration
Issue Action

Reported CCF value is
less than 0.1

or

System performance is
not satisfactory

• Make sure that the correct capillary was used, and that it is not
broken.

• Make sure that the laser output for the laser in use on the system is
correct.

• Make sure that the correct filters are installed in the LIF detector:

• Excitation: 488 nm

• Emission: 520 nm

• Replace the test mix, buffer, and capillary, and then do the
calibration again. If the issue continues, then contact SCIEX
Technical Support at sciex.com/request-support.

Reported CCF value is
between 0.1 and 10.0

There is no issue with the system. Run a standard and make sure that
the system performance is satisfactory.

Calibrate the LIF Detector (Optional)
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Issue Action

Reported CCF value is
more than 10

or

System performance is
not satisfactory

• Make sure that the laser output for the laser in use on the system is
correct.

• Make sure that the correct filters are installed in the LIF detector:

• Excitation: 488 nm

• Emission: 520 nm

• Replace the test mix, buffer, and capillary, and then do the
calibration again. If the issue continues, then contact SCIEX
Technical Support at sciex.com/request-support.

No Step Change Detected
The LIF calibration compares detector signals from a nonfluorescent solution and a known
fluorescent solution. When a rinse with nonfluorescent solution is done and then followed by a
rinse with fluorescent solution, the first part of the detector signal should be near zero and the
second part should be near the target fluorescent value. This detector output is in the shape of
a step and is referred to as a step change. If a step change is not seen, then the applicable
solutions are not passing the detector or the detector cannot detect the solutions.

1. Make sure that the switch on the right side of the laser is in the ON position.

2. Make sure that the laser that was supplied with the system is connected and the LASER ON
light is illuminated.

3. To make sure that the solution goes through the capillary, from buffer inlet position A1 to
an empty buffer vial in outlet position B1, use Direct Control to do a pressure rinse with CE
Grade water at 20 psi for 5 minutes.

4. When the rinse starts, open the sample cover. Look at the outlet end of the capillary in
position B1.

• If there are droplets on the outlet end of the capillary, then do step 6.

• If there are no droplets on the outlet end of the capillary, then the capillary is blocked or
the system has a pressure failure. Continue with the next step.

5. Replace the capillary, and then do the pressure rinse again.

• If there are still no droplets on the outlet end of the capillary, then contact SCIEX
Technical Support at sciex.com/request-support.

• If there are droplets on the outlet end of the capillary, then the detection system is the
only possible cause. Continue with the next step.

6. Make sure that the correct filters are installed in the LIF detector.

Calibrate the LIF Detector (Optional)
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7. If no step change is detected, then do the calibration procedure again. Refer to the section:
Calibrate the LIF Detector (Optional).

If the calibration procedure has been done more than 3 times, then manually set the
calibration correction factor (CCF) to 1.0, and then calibrate the LIF detector again.

If the LIF detector calibration continues to fail, then contact SCIEX Technical Support at
sciex.com/request-support.

Calibrate the LIF Detector (Optional)
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Contact Us

Customer Training
• In North America: NA.CustomerTraining@sciex.com

• In Europe: Europe.CustomerTraining@sciex.com

• Outside the EU and North America, visit sciex.com/education for contact information.

Online Learning Center
• SCIEX Now Learning Hub

Purchase Supplies and Reagents
Reorder SCIEX supplies and reagents online at store.sciex.com. To set up an order, use the
account number, found on the quote, order confirmation, or shipping documents. Currently,
customers in the United States, Canada, United Kingdom, Belgium, Netherlands, France,
Germany, and Switzerland have access to the online store, but access will be extended to other
countries in the future. For customers in other countries, contact a local SCIEX representative.

SCIEX Support
SCIEX and its representatives maintain a staff of fully-trained service and technical specialists
located throughout the world. They can answer questions about the system or any technical
issues that might arise. For more information, visit the SCIEX website at sciex.com or contact us
in one of the following ways:

• sciex.com/contact-us

• sciex.com/request-support

Cybersecurity
For the latest guidance on cybersecurity for SCIEX products, visit sciex.com/productsecurity.

Documentation
This version of the document supersedes all previous versions of this document.

To see this document electronically, Adobe Acrobat Reader is required. To download the latest
version, go to https://get.adobe.com/reader.
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To find software product documentation, refer to the release notes or software installation guide
that comes with the software.

To find hardware product documentation, refer to the documentation that comes with the system
or component.

The latest versions of the documentation are available on the SCIEX website, at sciex.com/
customer-documents.

Note: To request a free, printed version of this document, contact sciex.com/contact-us.
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